# Table of Contents

**REP200 USING QUERY MANAGER TO CREATE AD HOC QUERIES** ........................................ 1  
**COURSE AUDIENCES AND PREREQUISITES** ......................................ERROR! BOOKMARK NOT DEFINED.  
**LESSON 1: BASIC QUERY DEVELOPMENT – PLANNING INFORMATION** ......................... 3  
**LESSON 2: DEVELOPING AND REVISING QUERIES ON THE WEB** ................................. 5  
  2.1 Initial Navigation – Existing Query ..................................................... 6  
  2.2 Defining a New Query ............................................................................ 7  
  2.3 Joining Records .................................................................................... 8  
  2.5 Properties ............................................................................................ 12  
  2.6 Expressions .......................................................................................... 13  
  2.7 Prompts ................................................................................................ 15  
  2.8 Fields ................................................................................................... 16  
    2.8.1 Column Order ................................................................................. 17  
    2.8.2 Row Sort Order ............................................................................. 18  
    2.8.3 Field Properties ............................................................................. 19  
  2.9 Criteria .................................................................................................. 19  
    2.9.1 Grouping Criteria .......................................................................... 20  
    2.9.2 Adding Criteria ............................................................................ 21  
    2.9.3 Having Criteria ............................................................................ 22  
  2.10 View SQL Tab ..................................................................................... 24  
  2.11 Running the Query ............................................................................ 24  
**LESSON 3: RUNNING QUERIES ON THE WEB** .................................................... 25  
  3.1 Run to HTML ....................................................................................... 25  
  3.2 Run to Excel ....................................................................................... 27  
  3.3 Scheduling a Query ............................................................................... 29  
  3.4 Add to Favorites .................................................................................. 34
REP200 Using Query Manager to Create Ad Hoc Queries

Course Overview
The REP 200 Using Query Manager to Create Ad Hoc Queries is intended to provide the knowledge and skill to use the PeopleSoft Query Manager tool.

Course Outline
The following course sections and lessons provide information and procedures on creating ad hoc queries using the Query Manager tool in GEARS:

- Course Audiences and Prerequisites
- Lesson 1: Basic Query Development – Planning Information
- Lesson 2: Developing and Revising Queries on the Web
- Lesson 3: Running Queries on the Web
Course Audiences and Prerequisites

Audience(s)
The Judiciary audiences for this course are:

- AOC – Functional Super Users

GEARS Role(s)
This course is intended for Judiciary employees with the following GEARS role(s):

- AOC Query Manager User

Prerequisites
The recommended prerequisites for this course are:

- INT100 Introduction to GEARS
Lesson 1: Basic Query Development – Planning Information

Before beginning to create your query inside the application, it is best to plan the basics of what the query should produce. Use the following as a general guideline for planning a query. This list contains both basic and advanced query concepts.

1. Identify the fields that should display in your output.
2. If you need more than one table, determine if there are common fields between the tables that allow you to link them.
3. Determine what order to display the fields.
4. Determine what sorting of data is needed. (You can perform multiple sorts of data)
5. Determine how to title the columns (redefine delivered headings)
6. Determine if you need to sum data to subtotals.
7. Determine if you need to prompt the user for certain field inputs.
8. Determine if you need to define certain conditions or filters on your data (for example: select only when “x” is equal to a, b or c)
9. Determine if any other calculations are needed to provide the desired output.

In order to identify what fields to incorporate into the query, you will need to know what tables are used. The following charts provide a summary of key set up and transactional tables in the System. This is not a complete list but it does include many of the common records used.

Set Up tables:

<table>
<thead>
<tr>
<th>Applications</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP, AR</td>
<td>BANK_ACCT_TBL</td>
<td>Bank accounts</td>
</tr>
<tr>
<td>AP, AR</td>
<td>BANK_CD_TBL</td>
<td>Bank definitions</td>
</tr>
<tr>
<td>PO</td>
<td>BUYER_TBL</td>
<td>Buyer list</td>
</tr>
<tr>
<td>BL, AR</td>
<td>CUSTOMER</td>
<td>Customer list</td>
</tr>
<tr>
<td>BL, AR</td>
<td>CUST_ADDRESS</td>
<td>Customer address list</td>
</tr>
<tr>
<td>AP, PO</td>
<td>MASTER_ITEM_TBL</td>
<td>Inventory item list</td>
</tr>
<tr>
<td>AP, PO</td>
<td>VENDOR</td>
<td>Vendor list</td>
</tr>
<tr>
<td>GL</td>
<td>CLASS_CF_TBL</td>
<td>Chartfield list (Phase)</td>
</tr>
<tr>
<td>GL</td>
<td>DEPT_TBL</td>
<td>Chartfield list (Departments)</td>
</tr>
<tr>
<td>GL</td>
<td>GL_ACCOUNT_TBL</td>
<td>Chartfield list (Accounts)</td>
</tr>
<tr>
<td>GL</td>
<td>FUND_TBL</td>
<td>Chartfield list (Funds)</td>
</tr>
<tr>
<td>GL</td>
<td>OPER_UNIT_TBL</td>
<td>Chartfield list (Agencies)</td>
</tr>
<tr>
<td>GL</td>
<td>PRODUCT_TBL</td>
<td>Chartfield list (Sub-project)</td>
</tr>
<tr>
<td>GL</td>
<td>PROGRAM_TBL</td>
<td>Chartfield list (Bank codes)</td>
</tr>
<tr>
<td>GL</td>
<td>PROJECT</td>
<td>Chartfield list (Projects)</td>
</tr>
<tr>
<td>GL</td>
<td>CAL_DETP_TBL</td>
<td>Fiscal calendar set up</td>
</tr>
<tr>
<td>GL</td>
<td>PS_TREENODE</td>
<td>Tree node definitions – reporting</td>
</tr>
<tr>
<td>GL</td>
<td>PS_TREELEAF</td>
<td>Tree leaf definitions – reporting</td>
</tr>
<tr>
<td>GL</td>
<td>TREE_NODE_TBL</td>
<td>Tree node descriptions – reporting</td>
</tr>
<tr>
<td>Financials</td>
<td>PERSONAL_DATA</td>
<td>Employee list</td>
</tr>
<tr>
<td>GL</td>
<td>NVS_REPORT</td>
<td>NVision report request list – reporting</td>
</tr>
<tr>
<td>GL</td>
<td>NVS_SCOPE</td>
<td>NVision scope definition - reporting</td>
</tr>
<tr>
<td>GL</td>
<td>NVS_SCOPE_FIELD</td>
<td>NVision scope definition - reporting</td>
</tr>
<tr>
<td>GL</td>
<td>NVS_SCOPE_VALUE</td>
<td>NVision scope definition - reporting</td>
</tr>
</tbody>
</table>
### Transaction tables:

<table>
<thead>
<tr>
<th>Applications</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing</td>
<td>BI_HDR</td>
<td>Invoice headers</td>
</tr>
<tr>
<td>Billing</td>
<td>BI_LINE</td>
<td>Invoice line detail</td>
</tr>
<tr>
<td>AR</td>
<td>ITEM</td>
<td>Receivables</td>
</tr>
<tr>
<td>AR</td>
<td>ITEM_DST</td>
<td>Receivables – GL interface</td>
</tr>
<tr>
<td>GL</td>
<td>JRNL_HEADER</td>
<td>Journal headers – actuals</td>
</tr>
<tr>
<td>GL</td>
<td>JRNL_LN</td>
<td>Journal line detail- actuals</td>
</tr>
<tr>
<td>GL</td>
<td>LEDGER</td>
<td>Posted actual data</td>
</tr>
<tr>
<td>GL</td>
<td>LEDGER_KK</td>
<td>Posted budget and encumbrances</td>
</tr>
<tr>
<td>GL</td>
<td>KK_BUDGET_HDR</td>
<td>Budget journal headers</td>
</tr>
<tr>
<td>GL</td>
<td>KK_BUDGET_LN</td>
<td>Budget journal lines</td>
</tr>
<tr>
<td>AR</td>
<td>PAYMENT</td>
<td>Payments received</td>
</tr>
<tr>
<td>AP</td>
<td>PAYMENT_TBL</td>
<td>Payments made (checks processed)</td>
</tr>
<tr>
<td>Purchasing</td>
<td>PO_HDR</td>
<td>PO headers</td>
</tr>
<tr>
<td>Purchasing</td>
<td>PO_LINE</td>
<td>PO line detail</td>
</tr>
<tr>
<td>Purchasing</td>
<td>PO_LINE_DISTRIB</td>
<td>PO accounting distribution</td>
</tr>
<tr>
<td>Purchasing</td>
<td>RECV_HDR</td>
<td>Receiving information</td>
</tr>
<tr>
<td>Purchasing</td>
<td>REQ_HDR</td>
<td>Requisition headers</td>
</tr>
<tr>
<td>Purchasing</td>
<td>REQ_LINE</td>
<td>Requisition line detail</td>
</tr>
<tr>
<td>Purchasing</td>
<td>REQ_LINE_DISTRIB</td>
<td>Requisition accounting distribution</td>
</tr>
<tr>
<td>Purchasing</td>
<td>REQ_LINE_SHP</td>
<td>Requisition delivery information</td>
</tr>
<tr>
<td>AP</td>
<td>VCHR_ACCTG_LINE</td>
<td>Posted AP transactions-GL interface</td>
</tr>
<tr>
<td>AP</td>
<td>VOUCHER</td>
<td>Voucher table</td>
</tr>
<tr>
<td>AP</td>
<td>VOUCHER_LINE</td>
<td>Voucher line detail</td>
</tr>
<tr>
<td>AP</td>
<td>VCHR_PPAY_XREF</td>
<td>Voucher-Payment cross reference</td>
</tr>
</tbody>
</table>
Lesson 2: Developing and Revising Queries on the Web

On the Web, you can use PeopleSoft Query in the following ways:

- To display data in a grid.
  Preview queries within Query Manager, displaying the result set in a grid for review. This option is useful as you refine your queries.

- To run queries as a separate process.
  You can run queries as a separate process and have results sent to a separate browser window by selecting the Run option from Query Manager or Query Viewer.

- To schedule a query.
  You can choose to schedule queries so that they run at predefined times or on recurring schedules. The results of scheduled queries are routed to PeopleSoft Report Manager.

- To download query results to an Excel spreadsheet.
  Choose to have the data downloaded and formatted as a Microsoft Excel spreadsheet. This option is available in your query search results, or after you run or schedule a query.
2.1 Initial Navigation – Existing Query

Navigate: Reporting Tools > Query > Query Manager

- Enter a filter and click the **Search** button.
- The list of queries that match will display below the blue bar.
- Click on **Edit** to open the query.
2.2 Defining a New Query

Navigate: *Reporting Tools > Query > Query Manager > Create a New Query*

- Begin a query definition by selecting a first record (table).
- Enter the table name or part of the table name and click the Search button. You want the System to return a limited set of values making table selection easy.
- The list of tables will appear as shown below.

Click on the **Add Record** link of the record you need. For this example you will select **MASTER_ITEM_TBL – Item Master Header Table**.

- This will automatically place you into the Query tab. Use this page to select the fields you want to display in the query from this first record.
2.3 Joining Records

- To join another table, return to the **Records** tab.
- Enter the table name or hint and click **Search**.
- Select the table in the search output area by clicking on the **Join Record** link of the table you want to join.
- Select either the **Standard** or **Left Outer Join**. Note: Typically the standard join is correct. Left Outer Join should only be used with assistance from an experienced technical resource.

- Click on the blue link of Record you are joining to. In the example below, we will select **ASSET_ITEM_ATTR - Asset Item Attributes**.
You can accept the join conditions or uncheck certain fields to not use the Auto Join Criteria. It is recommended that you use the Auto Join Criteria. Click the Add Criteria button.

To view the fields of the other record, click the Plus button for that record.

You can select fields from the newly joined record to display in your query.
2.4 Preferences

We will explore two of the links at the bottom of the Query pages: Preferences and Properties.

- Click on the blue Preferences link.

Enable Auto Join ensures that Query will determine the join conditions for you as shown above. There are times when it won’t be able to identify joins. You will have to define them in those circumstances. Clicking Auto Preview will initiate a re-run of the query each time you wish to preview the query.
2.5 Properties

Properties provide general, high-level definitions for the query.

- **Query**: The query name
- **Description**: Optional – Provide a brief description
- **Folder**: You can organize queries into categories through folders. Here is where you enter a folder name for the query. This is useful if there are hundreds of queries and you want only specific queries such as those relating to “General Ledger”.
- **Query Type**: All ad hoc queries you create will be “User” type.
- **Owner**: Public or Private. Private means only available on your User ID.
- **Distinct**: Some queries will return duplicate rows because the query will find multiple rows of the same data that satisfy the query criteria. Checking this box eliminates your duplicate rows.
- **Query Definition**: Optional long description of your query.
- Note that the last person to update a query and the time of the update displays in properties.
- **Click OK.**
2.6 Expressions

**Expressions** are calculations that PeopleSoft Query performs as part of a query. Use them when you must calculate a value that PeopleSoft Query does not provide by default (for example, to add the values from two fields together or to multiply a field value by a constant). An expression can be treated just as if it were a field in the query: select it for output, change its column heading, or choose it as an “order by” column.

In Query Manager, you can use expressions in two ways:

- As comparison values in selection criteria.
- As columns in the query output.

To add or edit expressions for queries:

1. Click **Add Expression** to open the Edit Expression Properties page, where you can select expression types.

2. Select an **Expression Type** from the drop-down list.
If you select **Character**, enter the maximum length of the expression result in the *Length* field. If you select **Number** or **Signed Number**, enter the total number of digits in the *Length* field and the number of digits after the decimal point in the *Decimal* field.

3. If you are entering an aggregate value, such as **SUM**, **AVG**, or **COUNT**, select the **Aggregate Expression** check box.

4. In the **Expression Text** field, enter the expression.

   Query Manager inserts the expression into the SQL for you. You can include Oracle hints in PeopleSoft Query expressions using the following rules:
   - Expression containing a hint must begin with /*+
   - Expression can contain only one hint.
   - For example, only one set of /*+ */ is allowed.
   - Expression must contain complete hint.

   For example, it can’t have only /*+ or */. Both must be in the same expression.

5. Click **Add Prompt** to add prompt properties for this expression; click **Add Field** to add another field to this expression.
2.7 Prompts

Adding a prompt enables you to further refine a query when you run it. For example, suppose you wanted to change a query so that you could prompt the user to enter the month to list posted ledger data. Prior to adding the prompt, the query always retrieved rows for all months in the ledger based on a defined constant value. Adding a prompt to the query enables the user to enter any month, then the query can return only the fiscal period that needs to be analyzed.

When you run a query with a prompt, a dialog box appears for you to specify the required value. Enter the value into the text box. The query uses the value that you enter as the comparison value.

You can define single prompts in the Criteria section. Prompts for ranges should be defined here first.
2.8 Fields

The **Fields** tab provides a display of the fields that have been defined to display in the query. From this page, you can:

- Delete fields
- Change the column display order
- Change the row sort order
- Change the display heading
- Apply aggregate functions.
**2.8.1 Column Order**

Click the **Column Order** button to initiate changes to the column display order. Enter the number sequence for your column display as shown below.

Click **OK** to complete the change.
2.8.2 Row Sort Order

The Sort order defines how rows will display in the output. You can sort on one or more fields. The sort order dictates which field is the primary sort, secondary sort, etc.

If you want to sort a field in reverse (Z to A or 999 to 0 for example), change the “Direction” from Ascending to Descending. (Note how Fund Code will sort in reverse).
2.8.3 Field Properties
Field properties allow you to change the default heading display and apply an aggregate (group by) function to the field. Note that the “group by” is usually applied to the dollar amount field, especially for queries used in nVision matrix layouts.

2.9 Criteria
From the Criteria Page, you can

- Display the criteria
- Add Criteria
- Group Criteria
- Reorder the Criteria
- Edit existing Criteria
2.9.1 Grouping Criteria

Grouping criteria means putting two or more criteria within parenthesis ( ). This is necessary if you need to define “AND” and “OR” logic within the Criteria.
2.9.2 Adding Criteria

Criteria define a two-sided expression (x relation to y).

- Expression 1 must reference a field or expression.
- You must define a Condition Type (=, not=, Between, <, >, etc)

- Expression 2 must reference a field, expression, prompt, constant value or sub query.
As we are going to select Condition Type - equal to for this exercise, we will choose a Constant from the list of values under Expression 2.

2.9.3 Having Criteria

**Having** criteria allow you to define criteria on fields that have a Group By (aggregate expression) defined.
When you select **Field**, the eligible fields appear as blue links (note PRICE_LIST).

We want only those items where the list price is greater than $5.00.
2.10 View SQL tab

You can see the programming statements (SQL) produced from the other tabs. This can be a useful tool in debugging queries with errors and problems.

2.11 Running the Query

Click the **Preview** tab to process – run the query.
Lesson 3: Running Queries on the Web

Query Viewer is the recommended way to use the queries that have been created in Query Manager.

Navigate: Reporting Tools > Query > Query Viewer

Click the Search button.

You can also select a specific “folder” of queries such as “General Ledger”.

There are four processing options:

- **Run to HTML** (Run query to a Web view in HTML).
- **Run to Excel** (Run query to an Excel output).
- **Schedule** (Schedule the query to run at a future point in time).
- **Add to Favorites** (display the query as a “favorite” for your User ID.)

3.1 Run to HTML
Select a query by clicking on its blue Run to HTML link.

- Each output row is numbers and the total number of rows displays in the upper-right.
- Optional download to Excel format.
- Optional download to a text file.
- You cannot edit data in the HTML view. It is purely “read only”.
3.2 Run to Excel

Select a query to run by clicking on its blue Run to Excel link.

- Display is Web Excel. You can reformat column size and perform all of the Excel functions that exist in Windows Excel. If the toolbars are not displaying (as they are in the above example), then navigate: View > Toolbars to display the Excel functional buttons.
- The number of rows displays in cell B-1 in all Web-Excel outputs.
- This web output can optionally be saved to a directory on the C: drive or network such as My Documents. Once saved, it is a regular (.xls) Excel spreadsheet.
To save the web Excel output to a permanent Excel file, navigate: File > Save As

- The Windows save-dialog box appears.
- Be certain that the Save as Type is Microsoft Excel Workbook (*.xls).
- Enter a file name for this spreadsheet (choose a name)
- Click Save
3.3 Scheduling a Query

Scheduling queries facilitates running a large query or several queries at a planned future time and date. That plan could be a “one time” event or a schedule to repeat running the query on a daily or other timed basis. **Note:** The Database Administrator should be contacted before scheduling queries in order to avoid issues with scheduled database maintenance.

Navigate: **Reporting Tools > Query > Schedule Query**

- Click **Process Monitor**
- Select the Server Name **PSUNIX**.
- If the query run should repeat at a selected interval, enter a Recurrence. Leave **Recurrence** blank if this is a one-time run. Your common recurrence options are: Daily, Monday-Friday 5pm, and Every 15 Minutes.
- Select a **Run Date**.
- Select a **Run Time** (remember to identify AM or PM).
- Select the output **Format** type (Text, Excel, PDF or HTML)
- Click **OK**.

The Schedule Query page will re-appear with a **Process Instance** number when the query has been properly scheduled. You can monitor the process through the **Process Monitor**.
Click the blue **Process Monitor** link to access the Process Monitor. This shows the status of all your processing requests, including queries.

The process will progress through various Run Status stages:
Training Guide
REP200

- Queued
- Initiated
- Processing
- Success

Success means the process completed. If there is a problem you will receive an Error Status. Click the yellow Refresh button to obtain a more recent status from the Process Scheduler. The Success status shown below means the query is available for viewing.

Click the blue Details link to initiate the viewing process.
The Process Details page appears. This page provides access to technical information about the process that is particularly useful if there is an error in the process.

Click the blue “View Log Trace” link.

Click the blue output file link to display the query result.

Your selected output displays as shown below.
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>136-1D-3D-Dump Bld/VEHICLE</td>
<td>12900</td>
<td>1</td>
<td>9997</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>136-75-1D-Multipack VEHICLE</td>
<td>12440</td>
<td>1</td>
<td>118999</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>136-75-1D-Automatic VEHICLE</td>
<td>12454</td>
<td>1</td>
<td>124213</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>071-1X-1G-Golf Cart NON CAP</td>
<td>12446</td>
<td>1</td>
<td>3385</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>071-1X-1G-Golf Cart NON CAP</td>
<td>12446</td>
<td>1</td>
<td>3769</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>071-1X-50-Motorcycle VEHICLE</td>
<td>12446</td>
<td>1</td>
<td>15095</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>072-10-1D-Cap &amp; Cha/VEHICLE</td>
<td>12451</td>
<td>1</td>
<td>99159</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>072-10-1D-Cap &amp; Cha/VEHICLE</td>
<td>12450</td>
<td>1</td>
<td>55914</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>072-8-1D-Print Loud/VEHICLE</td>
<td>12448</td>
<td>1</td>
<td>99664</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>072-8-1D-Recycling truck Int</td>
<td>1601</td>
<td>1</td>
<td>1624627</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>090-15-10-Assistant Chief's Cap</td>
<td>12445</td>
<td>1</td>
<td>345</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>090-15-10-Captain's Cap Badge</td>
<td>12445</td>
<td>1</td>
<td>345</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>090-15-10-Chief's Cap Badge St</td>
<td>12445</td>
<td>1</td>
<td>345</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>090-15-10-Lieutenant's Cap Bd</td>
<td>12445</td>
<td>1</td>
<td>345</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>090-15-25-Assistant Chief's Shd</td>
<td>12445</td>
<td>1</td>
<td>156</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>090-15-25-Lieutenant's Badge St</td>
<td>12445</td>
<td>1</td>
<td>156</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>090-15-25-Captain's Badge Set</td>
<td>12445</td>
<td>1</td>
<td>156</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>090-15-25-Captain's Badge Set</td>
<td>12445</td>
<td>1</td>
<td>156</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>090-15-25-Captain's Badge Set</td>
<td>12445</td>
<td>1</td>
<td>156</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>090-15-25-Officer's Badge Set</td>
<td>12445</td>
<td>1</td>
<td>156</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>090-15-25-Officer's Badge Set</td>
<td>12445</td>
<td>1</td>
<td>156</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>090-15-25-Pttrn Wallet Bdl</td>
<td>12445</td>
<td>1</td>
<td>60.25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>090-15-25-Pttrn Wallet Bdl</td>
<td>12445</td>
<td>1</td>
<td>60.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>090-15-25-Pttrn Wallet Bdl</td>
<td>12445</td>
<td>1</td>
<td>60.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>090-15-25-Pttrn Wallet Bdl</td>
<td>12445</td>
<td>1</td>
<td>60.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>090-15-25-Pttrn Wallet Bdl</td>
<td>12445</td>
<td>1</td>
<td>60.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>090-15-25-Pttrn Wallet Bdl</td>
<td>12445</td>
<td>1</td>
<td>60.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>090-15-25-Pttrn Wallet Bdl</td>
<td>12445</td>
<td>1</td>
<td>60.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>090-15-25-Major's Cap Badge St</td>
<td>12445</td>
<td>1</td>
<td>345</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>090-15-25-Major's Cap Badge St</td>
<td>12445</td>
<td>1</td>
<td>345</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>090-15-25-Major's Cap Badge St</td>
<td>12445</td>
<td>1</td>
<td>345</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>090-15-25-Major's Wallet Bdl</td>
<td>12445</td>
<td>1</td>
<td>60.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3.4 Add to Favorites

Favorite queries make it easier to find those queries that you may need to run on a regular basis. Query Viewer will keep a list of queries identified as “favorites” on the main viewer page, eliminating the need to search each time the query is needed.

- Click the blue Favorite link

In this example, ASSET_ITEMS will appear in the user’s “My Favorite Queries” list.